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Using This Tutorial

Welcome to the Kurzweil 3000 for Windows Tutorial

This Tutorial is primarily for educators. It may also be 
suitable for users at the high-school level and above. 

Educators may consider using certain chapters/exercises, 
such as Chapter 5, Notes and the Creation of a Study 
Document and Chapter 6, Highlighting and the Creation of 
a Summary Document as foundation material for student 
training. Students in grade five and up may be able to go 
through Chapter 12, Test Taking, independently.

A Subset of Kurzweil 3000 Features

Although this Tutorial takes a comprehensive look at 
Kurzweil 3000, keep in mind that the features presented 
represent a subset of the features in the Kurzweil 3000 
software. To find details about all the features, use Kurzweil 
3000 online Help pages or see the Kurzweil 3000 for 
Windows User’s Guide.
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More Tips Throughout

Throughout the Tutorial, Tips provide suggestions for ways 
to use the features. More to Explore sections highlight other 
options you may want to try. 

This Tutorial is Modular

Each chapter in this Tutorial is modular and presents one 
main topic along with associated features and exercises. 
You can stop at the end of an exercise or a chapter and 
resume at another session, skip around or continue straight 
through. 

This Tutorial Assumes the Following

• You know basic operations in Microsoft Windows®, such 
as file system navigation.

• Kurzweil 3000 Version 10 is installed on your system. 

• You have Kurzweil 3000 for Windows Professional 
edition (Version 10) and a scanner installed if you plan 
on scanning.
2



Using This Guide
What You’ll Need to Complete the Tutorial

The majority of the exercises require certain documents 
from the Sample Documents folder, located in the following 
directory:

C:\Documents and Settings\your user name\My 
Documents\KESI\Kurzweil 3000\Sample Documents

If you have Windows 98, look in:

C:\My Documents\Kurzweil Educational Systems\Kurzweil 
3000\your user name\Sample Documents

We highly recommend going through Chapter 1, Kurzweil 
3000 Basics, as it contains instructions and information that 
you’ll apply as you work in the Tutorial.

For Technical Support

For Kurzweil 3000 Technical Support call 800-894-5374. If 
you are calling from outside the U.S. or Canada, dial 781-
276-0600.
Kurzweil 3000 for Windows Tutorial 3
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1 Kurzweil 3000 
Basics

In this chapter you’ll learn about the following basic Kurzweil 
3000 functions, many of which you’ll need throughout the 
Tutorial:

• The Benefits of Kurzweil 3000 on page 7.

• Starting Kurzweil 3000 on page 9.

• Exploring the Kurzweil 3000 Window on page 10.

• Exiting Kurzweil 3000 on page 12.

• Exploring Kurzweil 3000 Toolbars on page 13.

• Showing and Hiding Toolbars on page 14.

• Exploring the Menu System on page 15.

• Applying a Toolbar Set on page 16.

• Exploring Keyboard Shortcuts on page 17
Kurzweil 3000 for Windows Tutorial 5



• Working with Online Help on page 18.

• Working with Documents in Kurzweil 3000 on page 20.

• Opening and Saving a Document on page 21.

• Enlarging the Document View on page 23.

• Closing a Document on page 24.
6



Chapter 1. Kurzweil 3000 Basics
The Benefits of Kurzweil 3000 
Kurzweil 3000 offers features that benefit both students and teachers.

Kurzweil 3000 enables students to be independent learners and 
active classroom participants by:

• Supporting language decoding. Kurzweil 3000 provides multi-
sensory learning. Hear and see breaks in syllables, words, 
sentences, phrases or paragraphs as you read.

• Encouraging fluency. Kurzweil 3000 provides opportunities 
for repetition, and for customizing settings to match 
individuals’ current and target reading and learning levels.

• Aiding self-correction. Kurzweil 3000 reads back what’s 
typed, and provides easy-to-use reference and correction 
tools as students read, write, study and take tests.

• Promoting comprehension. Kurzweil 3000 study skills tools 
make it easy to produce many types of notes and summaries 
for review and to create outlines for composing writing 
assignments.

For teachers, Kurzweil 3000 offers quick preparation and 
customization of classroom and test material to meet any curriculum 
objective and educational initiative. You can:

• Provide students with access to a wide range of source 
material from scanned documents to Web pages to online 
books in Kurzweil 3000. 

• Use Notes, color Highlighters and editing tools to automate 
the preparation of pre-reading and active learning aids such 
as vocabulary and question lists.
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The Benefits of Kurzweil 3000
• Use the Bubble Notes feature to include additional 
instructional support such as prompts, directions and quick 
reading comprehension quizzes.

• Customize, enable and disable toolsets and features to 
accommodate multiple learning requirements and to provide 
a comfortable test-taking environment.
8



Chapter 1. Kurzweil 3000 Basics
Starting Kurzweil 3000
Upon installation, Kurzweil 3000 places an icon on your desktop.

Double-click the Kurzweil 3000 icon.

What You See: The open Kurzweil 3000 window. 

If you are using Kurzweil 3000 Network edition and you see a 
Welcome window, indicating that you are logging on to the 
server, type in your User Name and click OK.
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Exploring the Kurzweil 3000 Window
Exploring the Kurzweil 3000 Window
Have the Kurzweil 3000 window open and take note of its main parts: 

1. Main Menu Bar: Access all Kurzweil 3000 commands and 
features.

2. Toolbar Area: Access frequently used commands and 
features. The default Kurzweil 3000 window displays the 
Main and Reading toolbars.

Note: The Scan feature is available only in the Kurzweil 3000 
Professional edition. If you are using Kurzweil 3000 
Learnstation™, the Scan button is not available.

3. Toolbar Toggles: Click to show or hide the corresponding 
toolbar.

4. Document Window: View documents.

5. Status Bar: View system status.

1
2

3

4

5
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Chapter 1. Kurzweil 3000 Basics
You may also see the Tip of the Day window, such as the one shown 
below.
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Exiting Kurzweil 3000
Exiting Kurzweil 3000
Continue with the Tutorial by going to the next section, which 
discusses the Kurzweil 3000 toolbars. At any time during this Tutorial, 
however, you can exit Kurzweil 3000 by doing one of the following:

• From the File menu in the Main menu bar, choose Exit.
• Or click the Close (X) button in the upper-right corner of the 

Kurzweil 3000 window.
12



Chapter 1. Kurzweil 3000 Basics
Exploring Kurzweil 3000 Toolbars
The most important part of the Kurzweil 3000 window is the toolbar 
area because this is where you access the majority Kurzweil 3000 
functions.

There are four standard toolbars as well as a set of specialized 
“Sample” toolbars, which you can show, hide, apply or customize. This 
chapter contains exercises for showing, hiding and applying toolbars. 
For information about customizing toolbars, see Kurzweil 3000 online 
Help or the Kurzweil 3000 for Windows User’s Guide.

The default Kurzweil 3000 window displays the Main and Reading 
toolbars. You’ll work with other toolbars in later sections.

The Main toolbar lets you access the tasks you perform most often, 
such as reading and opening documents, as well as word lookup. The 
Scan button is only available in Kurzweil 3000 Professional edition.

The Reading toolbar lets you control how Kurzweil 3000 reads. This 
includes the ability to control the speaker; when to pause (reading 
mode); how much text to highlight (reading unit); and the reading 
speed.

There are also some page and document view options. 

This toolbar has function buttons, as well as control buttons and “drop-
down” lists. To show a list, click on the arrow button. To increase or 
decrease the value of a setting, click the up or down control button.

Typical “Drop-down” lists Typical Control Typical Function Buttons
Kurzweil 3000 for Windows Tutorial 13



Showing and Hiding Toolbars
Showing and Hiding Toolbars
In this exercise, you’ll display or “show” two other standard toolbars: 
the Study Skills and the Writing toolbars.

Showing and hiding toolbars is a handy feature for removing clutter 
from your Kurzweil 3000 window and for displaying only the tools you 
need for specific tasks, such as writing or making annotations.

If you are a teacher, this is one of the simplest ways to customize the 
toolset to accommodate students’ unique requirements.

1. Show and hide the Study Skills toolbar by clicking the green 
toggle.

2. Show and hide the Writing toolbar by clicking the blue toggle.

It’s also possible to use shortcut keys to show and hide toolbars:

• For the Main toolbar, press CTRL+SHIFT+F9.

• For the Reading toolbar, press CTRL+SHIFT+F10.

• For the Study Skills toolbar, press CTRL+SHIFT+F11.

• For the Writing toolbar, press CTRL+SHIFT+F12.

Throughout the Tutorial, you will need certain toolbars. 

Toolbar Toggles
Red: Main Toolbar
Yellow: Reading Toolbar
Green: Study Skills Toolbar
Blue: Writing Toolbar
14



Chapter 1. Kurzweil 3000 Basics
Exploring the Menu System
The Main menu bar contains all Kurzweil 3000 functions and features. 
Many of the functions and features in menus are also available as 
toolbar buttons.  

There are also shortcut (right mouse button) menus throughout the 
program. Let’s take a look at a shortcut menu.

1. Place your cursor in an empty spot in the toolbar or menu 
area.

2. Click the right mouse button to show the Toolbar shortcut 
menu.

An arrow next to a menu item indicates that there is a submenu. 
Ellipses (...) indicate that there is a dialog box.
Kurzweil 3000 for Windows Tutorial 15



Applying a Toolbar Set
Applying a Toolbar Set
On the Toolbar shortcut menu, under Apply Toolbar Set there are 
additional toolbar sets that you can use for a variety of situations. 

For instance, in test-taking situations, you may opt to show the Test 
Taking toolbar set, providing only the tools students need to 
accomplish test-taking tasks.

To display the Toolbar shortcut menu, place the cursor in the toolbar 
area and press the right mouse button.

To return to the default toolbars, on the Toolbar shortcut menu, 
choose Apply Toolbar Set, then select Classic.

Note: It’s possible to save a toolbar with a document. For more 
information, see Saving the Toolbar with the Test Document on page 177.
16



Chapter 1. Kurzweil 3000 Basics
Exploring Keyboard Shortcuts
Throughout Kurzweil 3000, there are keyboard shortcuts—function 
keys or combinations of keys that you can press to make selections or 
execute commands. Kurzweil 3000 supports typical Windows 
shortcuts, such as CTRL+O to open a file, as well as Kurzweil 3000 
ones, such as CTRL+K to magnify words.

1. Try pressing CTRL+F1 to open the Options dialog.

2. A quick way to make a selection is to find an underlined letter 
in the selection you want, then press ALT plus that letter’s 
key. For instance, all dialogs in Kurzweil 3000 have a Help 
button which, when selected, displays Help. Press ALT+H 
now to see the Help page.

3. When you’re done, press ALT+F4 to close the Help page.

4. Press ALT+C to close the Options dialog.

For a list of keyboard shortcuts, see Kurzweil 3000 online Help or the 
Kurzweil 3000 Quick Reference.
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Working with Online Help
Working with Online Help
You should also know how to access Help. In this exercise, you’ll 
explore the Kurzweil 3000 Help pages. Keep in mind that you also can 
find Help in dialog boxes.

1. Click the Help button in the Main toolbar to open the Help 
Home page.

What You See: The Help Home page.
Click blue text to go to a topic.

Go to Help Home Page.

Open Help Index.

Read Help page.
Print Help page.

Search using topic, 
keyword or phrase.

Magnify font.

Return to Kurzweil 
3000 window.
18



Chapter 1. Kurzweil 3000 Basics
Notice the Search box and button, which allows you to 
search by keyword or phrase.

2. Kurzweil 3000 online Help pages work like web links. To go 
to a topic, click the blue, underlined text. 

3. Try any of the following: 

• Click a text topic in the left pane. The topic page 
should appear in the right pane.

• Click in the Search box and type “keyboard shortcuts,” 
then press ENTER. A list of topics containing those 
keywords should appear in the left pane. Double-click 
a text topic to display the page in the right pane.

4. To read the contents of a page, click the Read button.

5. When you’re done, close the Help pages by clicking the 
Close button.
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Working with Documents in Kurzweil 3000
Working with Documents in Kurzweil 3000
You can work with almost any type of document in Kurzweil 3000, 
allowing you to access and use any printed material.

Image documents are documents that have image text and/or 
graphics. When you scan in pages, bring a document into Kurzweil 
3000 by using the KESI Virtual Printer or open a TIFF file in Kurzweil 
3000, you are working with image documents. These documents 
contain the image that you see on the screen, and “underlying text,” 
which is the text that the program “recognized,” and which Kurzweil 
3000 reads. It’s possible to edit the underlying text to fix recognition 
errors so that Kurzweil 3000 reads text correctly.

In image documents, you can use Reading, Reference, Study Skills 
(including Notes, Color Highlighters and Text Circles) and Test Taking 
tools.

You’ll use an image document in the next section, Opening and Saving 
a Document.

Text documents are documents that contain text only. You can create 
a text document by typing text into a new Kurzweil 3000 document or 
by extracting text, annotations or highlighted text. You can also open 
an existing text file or import it.

In text documents, you can use Reading, Reference, certain Study 
Skills, and Writing and Editing tools.

You’ll create a text document in Creating a Text Document on page 126.
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Chapter 1. Kurzweil 3000 Basics
Opening and Saving a Document
In this exercise, you’ll open a document and save it under a different 
name so that you can work with the newly saved document later in the 
Tutorial. You’ll need to do this procedure frequently throughout the 
Tutorial.

1. Click the Open button in the Main toolbar.

To use the keyboard shortcut, press CTRL+O.

2. In the “Kurzweil 3000” folder, find and double-click the 
“Sample Documents” folder. You can use the TAB key and 
the ARROW keys to navigate the dialog as you would any 
Windows dialog.

What You See: The contents of the Sample Documents 
folder.

3. Navigate to the desired file name to open it; in this case, 
“Time Travel.” Double-click the file to open it.

4. From the File menu, choose Save As. 

5. In the Save As dialog that appears, click the beginning of 
the file name.

6. Type “my.”

7. Click the Save button.

To use the keyboard shortcut, press CTRL+S.
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Opening and Saving a Document
What You See: A copy of the document with the new name. 
Check the top of the Kurzweil 3000 window to see the new file 
name.

8. Keep this document open and continue to the next 
exercise to enlarge the document view.
22



Chapter 1. Kurzweil 3000 Basics
Enlarging the Document View
Enlarging the document view can increase readability.

What You’ll Need to Do This Exercise: The “my Time Travel” 
document that you saved and opened in Kurzweil 3000 in the previous 
exercise.

1. Click the up or down Zoom buttons in the Reading toolbar 
to make the document larger or smaller.

2. Try other options, if you like. 

3. Continue to the next exercise to Close the document.
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Closing a Document
Closing a Document
There are three ways to close the document. You can:

• Choose Close from the File menu.

• Use the keyboard shortcut by pressing CTRL+F4.

• Click the second Close (X) button at the top right 
corner of the Kurzweil 3000 window. (Clicking the top-
most Close box closes the Kurzweil 3000 window and 
stops the program.)

You’re now ready to continue to the next chapter, where you’ll 
learn about document preparation.
24



2 Document 
Preparation

This chapter presents the document preparation process. 
You’ll scan a document to bring it into Kurzweil 3000 and 
explore a couple of features that aid in the preparation of the 
material for reading. Note that many of the features 
presented in this chapter, such as Scanning and Zone 
Editing, are available only in Kurzweil 3000 Professional 
edition.

Because this chapter takes you through a multi-featured 
process, you may opt to preview it, then go directly to 
Chapter 3, and return to these exercises when you have 
gained confidence in using Kurzweil 3000.

In this chapter, you’ll learn about:

• The Document Preparation Process on page 27.

• Scanning a Document into Kurzweil 3000 on page 31. 
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• Reading as Part of Document Preparation on page 33. 

• Changing the Reading Order Using the Zone Editor on page 35.

• Changing an Underlying Word on page 46. 

You’ll also find more scanning information in More to Explore: 

Trying Other Scanning Features on page 48.
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Chapter 2. Document Preparation
The Document Preparation Process
There are three main steps in the Kurzweil 3000 document 
preparation process:

• Step 1: Bring material into Kurzweil 3000. The material can 
be anything from a worksheet created in Microsoft Word, to a 
test, to entire textbook sections, to electronic files and 
content. You can do this by scanning pages, opening files 
created in other software, as well as by saving pages from the 
Web or by downloading files from online sources.

• Step 2: Read through the document to determine whether or 
not it is reading the way you want it to. For example, are there 
mispronunciations? Does the reading order make sense? 

• Step 3: Make the desired changes using Kurzweil 3000 
recognition correction and editing tools, such as the 
Underlying Text Editor and the Zone Editor.

When you scan a document into Kurzweil 3000, it becomes a Kurzweil 
3000 image file, with the following results:

• It displays the image of the text on the screen and retains the 
text from the optical character recognition (“recognition”) 
process “under” the image. This “underlying text” is what 
Kurzweil 3000 reads.

• Because character recognition is not always exact, the 
underlying text may contain character errors and 
mispronunciations. (Note that mispronunciations may also be 
the result of the selected reading voice.)
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The Document Preparation Process
• Kurzweil 3000 separates each chunk of recognized text into 
zones that you can re-order, delete, or choose to not have 
Kurzweil 3000 read.

You can customize how Kurzweil 3000 reads text by using the Zone 
Editor, which is what you will do later in this chapter. 

You can correct mispronunciations and recognition errors in a number 
of ways, as noted below. For step-by-step procedures on any of the 
following features, see Kurzweil 3000 online Help or the Kurzweil 3000 
for Windows User’s Guide.

• For mispronunciations that are the result of your reading 
voice, use the Pronunciations dialog, accessible from the 
Tools menu.
28



Chapter 2. Document Preparation
• To correct a frequently occurring recognition error, add it to 
the Corrections list, accessible from the Scan menu.

• To correct a single recognition error, you can use Change 
Underlying Word, accessible when you choose Correct 
Recognition from the Edit menu.

• To correct multiple recognition errors, you can use typical 
editing tools such as Spell Checking, and Find and Replace 
or Edit Underlying Text, accessible when you choose 
Correct Recognition from the Edit menu. 
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The Document Preparation Process
• To add material that did not get recognized, you can use the 
Override OCR option, accessible from the Zone Editor 
Properties dialog after you have added a zone.

• To have Kurzweil 3000 not read headers, footers or any text 
that appears in the same location throughout a document, 
select Header/Footer Editor from the Scan menu.
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Chapter 2. Document Preparation
Scanning a Document into Kurzweil 3000
The curriculum material you use most often comes in print format. To 
provide your students with access to these documents, you can scan 
the material into Kurzweil 3000. 

You can scan multiple pages as well as scan newspaper and table 
layouts if you have Kurzweil 3000 Professional edition. With Kurzweil 
3000 Professional Color, you can also scan in color.

Keep in mind that you can also teach students to scan their own 
material.

In this exercise, you’ll do a simple scan in black and white.

What You’ll Need to Do This Exercise:
• Kurzweil 3000 Professional edition and a properly installed 

scanner.

• A document to scan. In this case, use the Scanning Sample 
page at the back of the Tutorial. This exercise shows you the 
results of scanning that page.

• The open Kurzweil 3000 window.

1. Place the document face down on the scanner.

2. In the Kurzweil 3000 Main toolbar, click the Scan button.

The keyboard shortcut for starting a new scan is F9.
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Scanning a Document into Kurzweil 3000
What You See: The image of the document. Note that aspects 
of your scanned document, such as the page number may 
differ from the illustrations in this Tutorial. 

3. Save and rename the document:

Click the Save button in the Main toolbar to display the 
Save As dialog. Rename the document “Scan Sample,” 
then click Save. 

4. If you are exploring the document preparation process, 
continue to the next exercise, Reading as Part of 
Document Preparation.
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Chapter 2. Document Preparation
Reading as Part of Document Preparation
In preparing a document for students, it’s important to read through it 
after bringing it into Kurzweil 3000. 

As you read through the document:

• Notice the order in which Kurzweil 3000 reads the material. 
This is the ideal time to consider whether you want to change 
the reading order or have Kurzweil 3000 not read certain 
chunks of text. You can change the reading order using the 
Zone Editor from the Scan menu.

• Listen for mispronunciations, which are an indication that 
there are recognition errors and that you’ll need to change 
how Kurzweil 3000 reads the text. One way to correct 
recognition errors is to use Correct Recognition from the 
Edit menu.

What You’ll Need to Do This Exercise: 
• The open Kurzweil 3000 window.

• An open document in the Kurzweil 3000 window. You can use 
the Scanning Sample page from the previous exercise. 

1. In the document you are preparing, click where you want 
to start reading, then in the Main toolbar, click the Read 
button. To use the keyboard shortcut to start reading, press 
F3.

If you are using the “Scan Sample.kes” document from the 
previous exercise, click before the title, then click Read.
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Reading as Part of Document Preparation
2. Go through the document and listen for mispronunciations, 
and reading order.

What You Hear: If you are using the Scanning Sample page, 
one possible error is the mispronunciation of the word “Tavi” in 
the footer.

Note: Because each recognition process produces unique 
results, the errors you encounter may be different from what’s 
presented in this Tutorial.

3. If you are exploring the document preparation process, 
continue to the next exercise.
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Chapter 2. Document Preparation
Changing the Reading Order Using the Zone 
Editor
When you scan documents into Kurzweil 3000, the program 
recognizes blocks of text from the original, including page numbers, 
footnotes, captions and sidebars, as individual “zones.” 

When Kurzweil 3000 reads the document, it reads everything it 
recognizes and reads the zones in the order in which they appear. 
This may not be the preferred or ideal reading order. For instance, 
suppose there is a sidebar on the page. You may want Kurzweil 3000 
to read the sidebar contents after reading the primary text, not before. 

If you determine that your document could benefit from changing 
reading order or from having Kurzweil 3000 not read certain text, use 
the Zone Editor to re-order the zones. It’s best to do this before you 
perform other editing tasks.

In this exercise, you’ll change the reading order of zones and hear the 
results.

To do this exercise, use the “Scan Sample.kes” file you scanned in a 
previous exercise.

The screen shots in this exercise are of “Scan Sample.kes.”
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Changing the Reading Order Using the Zone Editor
1. From the Scan menu, select Zone Editor.

If you find that you need frequent access to this command, 
consider committing its keyboard shortcut, CTRL+F5, to 
memory.
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Chapter 2. Document Preparation
What You See: The document in Zone Edit mode. Each text 
block is a separate, yellow-highlighted “zone” with an assigned 
number indicating reading order.

By default, all zones are Primary Text zones, meaning they 
are read in reading order, left to right and down the page. 

It’s possible to change a zone to Secondary Text, which is not 
read unless the reader clicks it, or to Graphic, which Kurzweil 
3000 treats as art and does not read.
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Changing the Reading Order Using the Zone Editor
2. Change a zone to Secondary Text (in this case, zone 2, 
the sidebar text).

Click the desired zone, then hold down the right mouse 
button to display the Zone Editor shortcut menu. Select 
Properties.
38



Chapter 2. Document Preparation
What You See: The selected zone’s color dims and the Zone 
Properties dialog opens.

3. Select Secondary Text, then click OK.

Zone 2, 
Selected
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Changing the Reading Order Using the Zone Editor
What You See: The zone number changes and the color of the 
changed zone is now green.

Zone Number 
Changed
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Chapter 2. Document Preparation
4. Change a zone’s property to Graphic (in this case, zone 
number 4), containing the page number. 

This setting directs Kurzweil 3000 to not read the zone.

Click the desired zone, then hold down the right mouse 
button to show the Zone Editor shortcut menu. 

Select Properties.

In the Zone Properties dialog, click Graphic. 

Click OK.

What You See: The zone color changes to light blue, and 
there is no longer an associated zone number.

Current Zone Number 
for Selected Zone
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Changing the Reading Order Using the Zone Editor
What You See: In addition, notice that other zones may have 
been renumbered. If you have been following along with this 
document, the zone that you marked as a secondary zone 
earlier now has a different zone number, in this case, 4.

Graphic Zone with 
No Zone Number

Zone 
Renumbered
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Chapter 2. Document Preparation
5. Re-order a zone. 

Click on the desired zone (in this case, zone 3 in the 
footer), then hold down the right mouse button to show the 
Zone Editor shortcut menu. 

Select Properties.

In the Zone Properties dialog, click in the Reading Order 
box and type “1.” 

Click OK.

Change 
Reading Order
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Changing the Reading Order Using the Zone Editor
What You See: Renumbered zones throughout the document.

6. When you’re done with zone editing, display the Zone 
Editor shortcut menu, then click Zone Editor to deselect 
it, or press CTRL+F5.

7. In the message that appears, click Yes.

What You See: The document in its original view.

8. Click Read to hear how the zone editing affected the 
reading order. 
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Chapter 2. Document Preparation
What You Hear: If you have been following along with the 
Scanning Sample document and have made all the changes in 
the previous exercise, you hear Kurzweil 3000 read the footer 
first, the title next, then the body. 

It skips the sidebar text because it is labeled as Secondary 
Text. To hear Secondary Text, you must click at the beginning 
of the text and click Read.

Notice that Kurzweil 3000 does not read the page number.

9. If you want to end here, you may Save the document and 
Close it; otherwise continue to the next exercise.
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Changing an Underlying Word
Changing an Underlying Word
When you scan a document, it goes through a recognition process. 
Kurzweil 3000 displays the image of the text on the screen and retains 
the text from the optical character recognition (“recognition”) process 
“under” the image. 

There may be times when the process produces errors. For example, 
a common error is mistaking the letter “i” for the letter “l.”

If you scanned in the Scanning Sample page earlier and read through 
it, you may have heard just such an error in the word “Tavi” in the 
footer. Kurzweil 3000 may have read “Tavl” instead of “Tavi.”

In this exercise, you’ll change the underlying text for that word.

Note: Because each recognition process produces unique results, the 
errors you encounter may be different from what’s presented in this 
Tutorial.

What You’ll Need to Do This Exercise: 
• The “Scan Sample.kes” document open in Kurzweil 3000.

• A possible recognition error. If there aren’t any in your 
document, it’s OK to use any word to gain some practice 
through this exercise; just remember not to save the changes 
you make. 

1. Click the word “Tavi” in the footer.
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Chapter 2. Document Preparation
2. From the Edit menu, choose Correct Recognition, then 
choose Change Underlying Word or use the shortcut 
keys CTRL+W.

What You See: The Change Underlying Word dialog with 
the underlying text, spelled “Tavl.” Keep in mind that this is the 
recognized text and the text that you hear Kurzweil 3000 read.

3. Click inside the Replace with box, and type “Tavi” (with the 
letter “i” at the end).

4. Check to ensure the word is read correctly by clicking 
Read.

5. Click OK.

6. Save the document, if you want, and Close it. 
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More to Explore: Trying Other Scanning Features
More to Explore: Trying Other Scanning 
Features
While there are several more features on the Scan menu, you may 
want to try some of the following.

For detailed information, see Kurzweil 3000 online Help or the 
Kurzweil 3000 for Windows User’s Guide.

Problem or Type of Scan: Use:

Scan multiple pages when 
scanning using the flatbed.

Scan Repeatedly to add a new 
page after the current page in the 
scanned document.

Rescan. Rescan Page to replace the 
current scanned page with the 
new scanned page.

Insert a page. Insert Page to insert a new 
scanned page before the current 
page.

Delete a page. Delete Page to remove the 
current page.

Scan a color document. Use Color to scan in color.
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Chapter 2. Document Preparation
Teaching and 
Learning Tips

Once you have the document brought in and edited for 
recognition errors and reading order, consider the 
following:

• Use Notes and/or instructions for students. See 
Chapter 5, Notes and the Creation of a Study Document.

• Use highlighters to help readers identify types and 
levels of information. See Chapter 6, Highlighting and 
the Creation of a Summary Document.

• Extract highlights to create outlines and study 
guides. See Chapter 6, Highlighting and the Creation of a 
Summary Document.

• Use the Send To Email feature to send documents 
home from Kurzweil 3000 through e-mail. Find 
details in Kurzweil 3000 online Help.

If you find you are primarily doing document preparation 
tasks, consider using the Document Preparation 
toolbar for easy access to the tools you need. Show this 
toolbar by selecting it from the Apply Toolbar Set 
menu. See Chapter 1, Kurzweil 3000 Basics.
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More to Explore: Trying Other Scanning Features
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3 Reading and 
Reading Settings

In this chapter, you’ll learn about:

• Reading in Kurzweil 3000 on page 52.

• Starting and Pausing Reading on page 52. 

• Changing Reading Settings on page 54.

You’ll also find Language Learning Options in More to Explore: 

Accommodating Language Learning on page 57.
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Reading in Kurzweil 3000
Reading in Kurzweil 3000
Kurzweil 3000 Reading is designed to improve comprehension, 
support independent reading and increase reading speed.

It provides multi-sensory support. You not only hear the words read 
out loud, but you also see each word highlighted. 

As with all Kurzweil 3000 functionality, there are many ways to tailor 
Reading to accommodate individual preferences and different 
learning abilities, requirements and goals. 

Starting and Pausing Reading 
In this exercise, you’ll open a document and start and pause reading.

What You’ll Need to Do This Exercise: The document entitled 
“Condor” from the “Sample Documents” folder.

1. Find and Open the document “Condor” from the “Sample 
Documents” folder.

2. Click where you want Kurzweil 3000 to begin reading.

3. Click the Read button.

What You Hear: Kurzweil 3000 begins reading out loud. 
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Chapter 3. Reading and Reading Settings
What You See: As Kurzweil 3000 reads, it uses two-color 
highlighting to help you follow along. 

Take a quick look at the Read button; it is now the Pause 
button. 

4. Click the Pause button to have Kurzweil 3000 stop 
reading.

5. Proceed to the next exercise to change the Reading Unit 
and Reading Speed. Or if you want to end here, Close the 
document.

By default, 
Kurzweil 3000 
highlights the 
entire sentence 
in one color and 
the spoken word 
in another color.
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Changing Reading Settings
Changing Reading Settings
There are a number of Reading settings. The most frequently used 
ones are available as buttons on the Reading toolbar; others are in 
the Reading pane, accessible from the Tools Options menu. 

In this exercise, you’ll change the Reading Speaker, Reading Unit 
and Reading Speed from the Reading toolbar.

What You’ll Need to Do This Exercise: The document entitled 
“Condor” from the “Sample Documents” folder.

1. Open the document “Condor” from the “Sample 
Documents” folder, if it isn’t already open.

2. Change the reading speaker. 

Click the Reading Speaker list arrow. 

Note that the list you see is based on your system’s speech 
engine.

Reading Speaker Reading Unit Reading Speed
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Chapter 3. Reading and Reading Settings
3. Change the reading unit:

Click the list arrow in the Reading Unit box. 

Select Paragraph.

This setting is useful for checking organization of thought.

4. Click the Read button to hear the selected reading unit. 

What You See: Kurzweil 3000 now highlights the paragraph 
and the spoken word.

5. Click the Pause button to stop reading.

When Reading 
Unit is set to 
Paragraph, 
Kurzweil 3000 
highlights the 
entire 
paragraph in 
one color and 
the spoken 
word in another 
color.
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Changing Reading Settings
6. Try changing the unit to Line or Phrase. When you’re 
done, return the unit to Sentence.

7. Change the reading speed by doing one of the following:

Click the Up or Down arrow in the WPM (Words Per 
Minute) box to increase or decrease the value.

Or click the value box and type the value you want. Try 
200.

8. Click the Read button to hear the new reading speed. 
When done, click Pause.

9. Now try 90, then click Read. What do you hear? When 
you’re done, click Pause and reset the WPM to 170.

10. Close the document without saving it.

Teaching and 
Learning Tips

If your goal is to improve reading and comprehension, 
begin with the Word reading unit.

If your goal is to increase reading speed, start with a 
comfortable speed or a target speed. With mastery, 
increase the speed.
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Chapter 3. Reading and Reading Settings
More to Explore: Accommodating Language 
Learning
Kurzweil 3000 supports many languages. To explore a document for 
language learning, Open “Josefina,” a Spanish document from the 
“Sample Documents” folder.

Open the Reading pane, accessible from the Tools Options menu, 
and select the desired language from the Language list (in this case, 
Spanish). Notice that the Speaker list changes; you can select an 
alternate speaker from this list. Click Apply and then OK.

Click Read to hear the document in the newly selected language.

Note: To scan a document that is in another language, use the OCR 
Language list in the Scanning pane, accessible from the Tools 
Options menu.

Change Reading 
Language.

When you change the 
Language, the Speaker 
list also changes.
Kurzweil 3000 for Windows Tutorial 57



More to Explore: Accommodating Language Learning
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4 Reference Tools 

In this chapter, you’ll learn about:

• The Syllables, Synonyms and Definition features in 
Reference Tools on page 60.

• Looking Up a Word on page 60. 

In addition, there are two exercises of interest: Creating a 

Word List Containing Definitions on page 64, in which you’ll learn 
how to create a study document by looking up and dragging 
and dropping definition text, and More to Explore: Using Online 

Encyclopedias on page 70, in which you can explore Kurzweil 
3000 Online Encyclopedia lookup.
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Reference Tools
Reference Tools 
Kurzweil 3000 provides a comprehensive set of reference tools, 
including dictionary, synonyms, syllables and spelling lookup, 
designed to help students improve vocabulary and increase word 
knowledge while reading.

Looking Up a Word
In this exercise, you’ll copy a document from the “Sample Documents” 
folder and use it to explore three lookup tools: Spelling, Syllables and 
Synonyms.

What You’ll Need to Do This Exercise: The document entitled 
“Horse’s Tale,” from the “Sample Documents” folder. It’s not necessary 
to save this document.

1. Open “Horse’s Tale” in the Sample Documents folder.

2. Click the Read button in the Main Toolbar.
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Chapter 4. Reference Tools
What You See and Hear: Kurzweil 3000 reading the 
document aloud and highlighting words as it reads.

3. Click the Pause button when you come across a word that 
you want to spell out loud, then double-click the word. Try 
“hostile.”

4. Click the Spell button in the Main toolbar.
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Looking Up a Word
What You See and Hear: The Word Spelling dialog and 
Kurzweil 3000 saying and spelling the word while displaying 
each letter.

5. Click Done to close the dialog.

6. Click the Syllables button.

What You See and Hear: The Syllables dialog and Kurzweil 
3000 saying the word and emphasizing the syllables.

Notice the Next button. It is an indication that this word has 
additional pronunciations. Click Next to give it a try.
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Chapter 4. Reference Tools
7. Click Done to close the dialog.

8. With the word still selected, click the Synonym button.

What You See: The Synonym window.

9. Click Read to hear the contents of the Synonym window. 
When you’re done, click the Close button in the Synonym 
window.

10. With the word still selected, click the Definition button.

What You See: The Definition window.

11. Click Read to hear the contents. When you’re done, click 
the Close button in the Definition window.

12. Close the document.
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Creating a Word List Containing Definitions
In this exercise, you’ll create a text document that will become a word 
list and display it side by side with another document. Next, you’ll work 
with the Definition lookup tool and drag and drop definition text into the 
new word list document.

What You’ll Need to Do This Exercise: The “Horse’s Tale” document 
from the “Sample Documents” folder.

1. Open the “Horse’s Tale” document from the “Sample 
Documents: folder.

2. Click the New File button in the Main toolbar.

What You See: The new text document covers the currently 
open document.

3. From the Window menu, choose Tile Vertically. (You 
could also choose Tile Horizontally if you are more 
comfortable with a horizontal display.)
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Chapter 4. Reference Tools
What You See: The documents side by side. Note that there 
may be slight differences between your documents and the 
ones in the Tutorial illustrations.

4. In the “Horse’s Tale” document, select a word. In this 
example, the Tutorial is using the word “hostile.” 

5. Click the Definition button.
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Creating a Word List Containing Definitions
What You See: The Definition window.

6. Click Read to hear its contents.

7. From the Window menu, choose Tile Vertically again to 
display the Definition window along with the “Horse’s 
Tale” document and the word list document.
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Chapter 4. Reference Tools
What You See: There should be three panes.

8. Now copy the definition text to the new document by 
selecting it and dragging and dropping it. 

Note: When you drag and drop text from the Definition 
window, it temporarily appears to be empty. 

Document Window Definition Window New document Window
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Creating a Word List Containing Definitions
What You See: The definition text “dropped” into the word list 
document.

9. If you want, find additional definitions and drag and drop 
them into the word list document.

10. When you’re done, click the Close button in the original 
document window to close it.

11. Save, rename and Close the word list document.

Definition Dragged into the New Document.
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Chapter 4. Reference Tools
Teaching and 
Learning Tips

Once you have created the word list document, you can 
distribute it to both your Kurzweil 3000 and non-
Kurzweil 3000 students as a pre-reading document.

Students who use Kurzweil 3000 can then have the 
program read the material, perhaps even repeatedly, to 
learn the content.

If you have students adept at using Kurzweil 3000, you 
can have them follow these instructions to create their 
own word lists from which they can study new 
vocabulary.

You can create other study documents easily by using 
Notes, Highlighters, and the Extract feature. See the 
next two chapters.
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More to Explore: Using Online Encyclopedias
More to Explore: Using Online Encyclopedias
In addition to Definition, Syllable and Synonym lookup, Kurzweil 
3000 also provides an Online Reference Lookup feature, accessible 
from the Online menu. 

Using this feature, you can search through a set of online 
encyclopedias and reference sites, such as Columbia and Wikipedia, 
for the information you want.

Here are some helpful notes to keep in mind:

• To use this feature, your system must have Internet access.

• If you’ve worked with the other Kurzweil 3000 lookup tools, 
you know that there are two ways to do this: type a word or 
select a word. 

• When opting to look up a word you type, you don’t need to 
have a document open. 

• Additionally, when using the Online Reference Lookup 
feature, you can look up a word or phrase.

In the following exercise, you’ll select a word to look up and type a 
word to look up.

1. Open a document of your choice. To use the same document 
presented in this exercise, find and Open “Horse’s Tale” from the 
“Sample Documents” folder.
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Chapter 4. Reference Tools
2. Try one or both of the following methods:

Method A: Look up a selected word or phrase: With the 
“Horse’s Tale” document open, select Mark Twain in the “by” line, 
then select Online Reference Lookup from the Online menu. In 
the Online Reference Lookup dialog, select Encyclopedia 
Britannica Concise from the Search Site list. Click Search.

What You See: The search results. You can follow the links to 
other information and articles. 

You can Read the contents and/or Close the window.

Method B: Look up a typed word or phrase: Select Online 
Reference Lookup from the Online menu. This time in the 
Online Reference Lookup dialog, select Encyclopedia 
Britannica Concise from the Search Site list, then type the word 
or phrase you want (in this case, “king arthur”). Then click Search.
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More to Explore: Using Online Encyclopedias
What You See: The search results. You can follow the links to 
other information and articles.

3. Close any windows when you’re done.
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5 Notes and the 
Creation of a Study 
Document

In this chapter, you’ll learn about:

• Kurzweil 3000 Notes on page 75.

• Creating and Working with Sticky Notes and Text Notes on page 

77. 

• Creating and Working with Footnotes on page 81.

• Showing and Hiding Notes on page 84.

• Creating a Study Document by Extracting Notes on page 85. 
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You’ll also find out how to delete notes in More to Explore: 

Deleting a Note on page 89, and how to find notes in More to 

Explore: Finding Notes in a Document on page 89.
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Chapter 5. Notes and the Creation of a Study Document
Kurzweil 3000 Notes
There are many ways to take notes in Kurzweil 3000: the color 
Highlighters work similarly to highlighter pens, and with half a dozen 
colors, they are a convenient way of noting different levels of 
information. Text and Sticky Notes allow you to embed annotations. 
Kurzweil 3000 can read highlighted text as well as contents in Text and 
Sticky Notes. Voice Notes enable you to record annotations. Bubble 
Notes are teacher-created, interactive instructional support. In 
addition there are Footnotes and Text Circle tools.

If you are a student, you can use these study skills tools to help you 
remember key points, to create study notes and questions, and/or to 
insert footnotes in research papers. Knowing how to use Text Notes is 
also important for taking tests using Kurzweil 3000. Bubble Notes can 
enable you to respond to your instructor’s prompts and/or questions.

If you are a teacher, Kurzweil 3000 Notes can help you embed 
reminders, and additional information in class work as well as in test 
material. Bubble Notes are especially useful as instructional support, 
allowing you to add prompts and questions to ensure that students 
stay on task and/or are comprehending the material.

In this chapter, you’ll work with Sticky, Text and Footnotes. For 
information on Voice Notes, see Kurzweil 3000 online Help or the 
Kurzweil 3000 for Windows User’s Guide. For information and 
exercises on:

• Color Highlighters, see Highlighting Text in a Document on page 
91. 

• Text Circle tools, see Using the Text Circle Tool for Multiple Choice 
on page 188.
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Kurzweil 3000 Notes
To show the Study Skills toolbar: 
To do the exercises in this chapter, you must have the Study Skills 
toolbar showing.

Click the green Toggle along the left edge of the Kurzweil 3000 toolbar 
area to show or hide the Study Skills toolbar. You can also use 
CTRL+SHIFT+F11.

Green Toggle Shows/Hides the Study Skills 
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Chapter 5. Notes and the Creation of a Study Document
Creating and Working with Sticky Notes and 
Text Notes
In this exercise, you’ll copy a document from the “Sample Documents” 
folder and work with Sticky Notes and Text Notes.

Note: Sticky and Text Notes are available only in image documents.

Sticky Notes are helpful as reminders and prompts and are useful for 
embedding instructions and questions. 

Text Notes are useful not only for adding study notes to documents, 
but they are also the tool you use to fill out forms, worksheets, and 
tests in Kurzweil 3000.

It’s possible to “extract” Sticky Notes and Text Notes into a new text 
document, which you can then use as a study document. See Creating 
a Study Document by Extracting Notes on page 85.

What You’ll Need to Do This Exercise: The document entitled 
“Horse’s Tale.” 

1. Find “Horse’s Tale” in the “Sample Documents” folder. 
Copy it, rename it “my Horse’s Tale,” and Open it.
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Creating and Working with Sticky Notes and Text Notes
2. Create a Sticky Note:

Click the Sticky Note button in the Study Skills toolbar.

Because Sticky Notes cover the images below, you may 
want to place them in empty spaces. Margins are ideal 
spots. 

Click in the margin where you want to place the note.

Type your note. In this case, “Who is telling the story?”

To create new text lines in the Sticky Note, press the Enter 
key for a hard return. 

When you are done, click outside the note.

What You See: The Sticky Note in the margin.

3. Resize the Sticky Note:

Point to the left or right border to show the size arrow.

Move the mouse side to side until the note is the desired 
size.
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Chapter 5. Notes and the Creation of a Study Document
What You See: The resized Sticky Note.

4. Move the Sticky Note:

Point to the top or bottom border of the note to show the 
four-arrowed compass.

Move the note to a new location.

5. Create two more Sticky Notes in the same way, if you want 
additional practice. 

6. Create a Text Note:

Click the Text Note button in the Study Skills toolbar.

Click where you want to place the note.

In the empty Text Note, type the desired text. If you want 
to follow our example, type: “Use three words to describe 
the main character.”

To create new text lines, use the Enter key for line breaks.

When you are done typing, click outside the note.
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Creating and Working with Sticky Notes and Text Notes
What You See: Notice that the Text Note is transparent.

7. Edit a note:

Click inside the desired note. Use text editing functions to 
edit it.

When you’re done, exit the note by clicking outside it.

8. This is a good time to Save the document.

9. To read a Sticky Note or Text Note: Click inside it, then click 
the Read button. 

10. When you’re done, click outside the note.

11. Continue to the next exercise. If you need to end here, click 
the Close button. 
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Chapter 5. Notes and the Creation of a Study Document
Creating and Working with Footnotes
Footnotes work in either image or text documents. Each footnote has 
a numbered anchor and is associated with the text in which you place 
it. Footnotes are ideal for research papers and study documents.

What You’ll Need for This Exercise: The document entitled “my 
Horse’s Tale” from the previous exercise. 

1. Open “my Horse’s Tale.” 

If you did not do the previous exercise, find “Horse’s Tale” 
in the “Sample Documents” folder. Copy it, rename it “my 
Horse’s Tale,” then Open it.

2. Click on the word to which you want to attach the Footnote; 
“Buffalo Bill,” in the first paragraph is a good spot.

3. Click the Footnote button in the Study Skills toolbar.
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Creating and Working with Footnotes
What You See: The Footnote number in red, “anchored” next 
to the word, and the Footnote window in the bottom half of the 
Kurzweil 3000 window.

4. Type inside the Footnote window. 

5. To read a Footnote:

If your cursor is already in an open Footnote, click Read. 

If a Footnote is closed, double-click on the Footnote 
anchor number to open the Footnote window, then click 
Read. Kurzweil 3000 automatically reads the contents by 
default.
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6. When you’re done with a Footnote, close it by doing one of 
the following:

• Click the Footnote Close button in the Study Skills 
toolbar.

• Click the Close X box in the Footnote window.

• Press the ESC key.

• Or double-click the anchor of the open Footnote. This 
is a handy method for opening any Footnote.

7. This is a good time to Save the document.

8. Continue to the next exercise. If you need to end here, click 
the Close button. 
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Showing and Hiding Notes
You can show or hide Kurzweil 3000 Notes. Hiding annotations does 
not remove them from the document, but provides a clear view of the 
document.

What You’ll Need to Do This Exercise: A few Sticky Notes, Text 
Notes and/or Footnotes created in “my Horse’s Tale” document, and 
the document open. See the previous exercises on creating Notes. 

1. Hide Notes:

From the View menu, click Annotations.

By default, all notes are checked (that is, visible).

Click the annotations you’d like to hide. In this case, click 
the Show Notes check box to uncheck it.

2. Take a look at the document. The Sticky Note, Text Note 
and Footnote anchor are no longer visible.

3. Click Show Notes again to make notes visible again.

4. If you plan on continuing to the next exercise, Save the 
document. You can also Close and Save the document for 
another session.
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Creating a Study Document by Extracting 
Notes
Creating a variety of study tools including study guides, summaries, 
outlines and simple word lists is very easy to do with the Extract 
feature.

What You’ll Need to Do This Exercise: A few Sticky Notes, Text 
Notes and/or Footnotes created in “my Horse’s Tale” document, and 
the document open.  

1. From the File menu, choose Extract.
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What You See: The Extract Annotations dialog.

2. In the Extract Annotations dialog, click the Annotations 
radio button, then click OK.
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What You See: Kurzweil 3000 creates and opens a new text 
document with all the notes you had created. Your document 
may not have the same content as the one below:

Kurzweil 3000 presents the extracted notes by page and in 
Footnotes, Text Notes, and then Sticky Notes order.

Note: You can edit extracted documents using text editing 
functions. 

3. Save and Close the extracted document. 
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Teaching and 
Learning Tips

Once you have the extracted document, you can edit it 
to contain just one type of information, such as 
questions or instructions. You can then print the 
document and distribute it to all students and have a 
Kurzweil 3000 version for students who’ll be using the 
program to work with the document.

Encourage students to take notes using Kurzweil 3000 
notes, extract the notes, and read and re-read the 
material to learn it. 
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More to Explore: Deleting a Note
To do this exercise, you can use the “my Horse’s Tale” document 
containing notes. 

More to Explore: Finding Notes in a Document
To do this exercise, use “my Horse’s Tale” document containing notes. 

1. Click a note you want to delete.

2. Click the Delete note button in the Study Skills toolbar. 

3. In the message dialog, click Yes to confirm.

1. Click at the beginning of the document.

2. From the Edit Find menu, select Object to open the Find 
Object dialog.

3. Select Note, then click Find.
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6 Highlighting and 
the Creation of a 
Summary 
Document

In this chapter, you’ll learn about:

• Kurzweil 3000 Color Highlighters on page 90.

• Highlighting Text in a Document on page 91.

• Using Reading by Highlight to Study on page 93.

• Creating a Summary Document or Outline on page 94. 

In More to Explore: Erasing Highlights on page 99, find out how 
to erase highlights. In More to Explore: Labeling Highlight Colors 
on page 100, learn how labeling highlight colors helps in 
organizing information.
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Kurzweil 3000 Color Highlighters
Color Highlighters are another type of Kurzweil 3000 study skills tool. 
The benefits of Kurzweil 3000 electronic highlighting include the ability 
to:

• Associate different concepts with different colors. For 
example, you can use yellow for main ideas, green for details, 
cyan for vocabulary, and so on. 

• Hear only the material you highlighted.

• Extract highlighted material and create new documents that 
can serve as study aids, such as pretest questions, outlines 
and summaries.

Highlighters work in both image and text documents, and can be used 
to select answers on Multiple Choice tests.

To show the Study Skills toolbar: 
To do the exercises in this chapter, you must have the Study Skills 
toolbar showing.

Click the green Toggle along the left edge of the Kurzweil 3000 toolbar 
area to show or hide the Study Skills toolbar. You can also use 
CTRL+SHIFT+F11.

Green Toggle shows/hides the Study Skills toolbar
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Highlighting Text in a Document
Kurzweil 3000 provides multiple highlighting colors, making it easy to 
organize and categorize information while reading or studying.

In this exercise, you’ll use yellow for main ideas and green for details.

What You’ll Need to Do This Exercise: The document entitled “my 
Horse’s Tale.” 

1. Open the “my Horse’s Tale” document. If you don’t have it, 
you can find “Horse’s Tale” in the “Sample Documents” 
folder. Copy it, rename it “my Horse’s Tale,” then Open it.

2. Highlight a main idea by using the yellow highlighter:

In the document, click the Yellow Highlighter button in the 
Study Skills toolbar.

Click at the beginning of the main text you want, then drag 
the Highlighter cursor to the end of the phrase to select it. 
In this case, try, “Buffalo Bill’s.”

3. Highlight details for that main idea by using the green 
highlighter:

Click the Green Highlighter button.

Select details: In this case, try as many of the following as 
you want: “two hundred pounds,” “over six feet,” “young,” 
“graceful,” “quick,” “handsome” and “braver.”
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4. Highlight another main idea and its associated details.

Try: “horse” for main idea in yellow highlighter. In green 
highlighter select: “not large,” “good family,” “best-
educated,” and “best-mannered.”

5. To stop highlighting, click the Highlighter button you were 
just using. 

What You See: Some text as main ideas highlighted in yellow 
and other text as details highlighted in green. 

6. This is a good time to Save the document.

7. Continue to the next exercise. If you need to end at this 
time, click Close. 

Main ideas 
appear in 
yellow 
highlight.

Supporting 
details 
appear in 
green 
highlight.
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Using Reading by Highlight to Study
This feature is particularly useful for reviewing a document or studying 
for a test.

In this exercise, you’ll read the highlights you created in the previous 
exercise.

What You’ll Need to Do This Exercise: The document entitled “my 
Horse’s Tale,” from the previous exercise.

1. Open “my Horse’s Tale” from the previous exercise. It 
should have text that has been highlighted. 

2. Click the Reading Unit list arrow in the Reading toolbar, 
and select Highlight to hear only the material you 
highlighted.

3. Click anywhere before the first highlighted text. 

4. Use the Read/Pause button to read and stop reading.

What You Hear: Kurzweil 3000 reads the highlighted text.

5. When you’re done, reset the Reading Unit to Sentence. 

6. Continue to the next exercise. 
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Creating a Summary Document or Outline
You’ve already experienced how easy it is to create study aids. In this 
exercise and the next, you’ll create a summary document. 

Because that summary document will have a main idea and details 
that are indented, it can serve multiple purposes: as a study 
document, as a pre-reading exercise, and as an outline from which 
students can compose an essay. 

In this first exercise, you’ll specify indents and then use the Extract 
feature to create the summary document. These indents serve to 
distinguish a main idea from a detail. 

What You’ll Need to Do This Exercise: The document entitled “my 
Horse’s Tale” from the previous exercise. 

1. Open “my Horse’s Tale” from the previous exercise. This 
document should contain multi-color highlights to denote 
multi-level information.
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2. From the File menu, choose Extract Annotations.

What You See: The Extract Annotations dialog.
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Creating a Summary Document or Outline
3. Set an indent:

Recall that you used the green highlighter for details. In the 
Extract dialog, click the Indent box for Green Highlight 
and type “0.2” to place an indent for all details.

4. If you want the extracted document to be in outline format, 
click a highlight color’s Prefix box and type one of the 
following:

“%I ” (uppercase “i”) for uppercase Roman numeral list.

“%i ” for lower-case Roman numeral list.

“%A ” for upper-case lettered list.

“%a ” for lower-case lettered list.

“% ” for numbered list.

Note: Be sure to add a space ( ) after the prefix to set it 
apart from the text. You may also want to use a period or a 
closed parenthesis in addition to the space.

A typical outline might have “%I.) ” for yellow/main idea 
highlights and “%A. ” for green/subtopic or supporting fact 
highlights. 
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What You See: A new document with all the material you 
highlighted. Notice that details are indented from the main idea 
just as you specified.
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If you had opted to make this new document an outline, it might 
look like the following image:

You can edit the new extracted document using text editing 
functions. In the example above, for instance, you could delete 
the apostrophe and the letter “s” after the word “Bill” and the 
other unnecessary punctuation marks to finish the outline.
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More to Explore: Erasing Highlights

5. Close and Save the newly created document:

Click Close. 

In the Close dialog, click Yes to save it.

In the Save As dialog that appears, type the new name 
“my summary” or “my outline” in the File Name box.

Click Save.

6. Close “my Horse’s Tale” unless you want to do a More to 
Explore exercise.

1. Click the Erase button in the Study Skills toolbar.

2. Drag the cursor over the desired highlighted text.
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More to Explore: Labeling Highlight Colors
Since you can use the different color highlighters as a way to organize 
information and ideas, it may be helpful to label each color so that you 
and your students can remember which color to use for different types 
of information. Doing this also promotes consistency and provides 
students with additional experience in organizing information and 
thoughts. 

A possible labeling scheme might be “Main Idea” for yellow 
highlighting, “Detail” for Cyan, and so on.

1. To label highlighters, use the Highlighters pane, accessible from 
the Tools Options menu.

2. In the Highlighters Options pane, click in the desired Caption 
text box, type the desired name, then click Apply and OK.

In the following example, the captions are set to “Main Idea” and 
“Details,” etc.
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3. To see a label, point your cursor at the desired color highlighter 
button. The label appears in the button’s Tool Tip, as in the 
example below. 

Note: Highlight label changes also appear in the following places: 

• In the Tools Highlight menu.

• In the Extract Annotations dialog.

• In the Print Highlighted Text dialog.
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7 Bubble Notes as 
Instructional 
Support

In this chapter, you’ll learn about:

• Bubble Notes on page 105.

• Opening and Hearing a Bubble Note on page 107.

• Selecting Answers for Check Box Questions on page 110.

• Matching Answers on page 113.

• Adding an Instructional Note on page 116.

In More to Explore: Setting Up Uninterrupted Reading on page 120, 
find out how to not have Bubble Notes open automatically 
for uninterrupted reading.

There are a couple of additional More to Explore sections: 
More to Explore: Editing a Bubble Note on page 120, More to 
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Explore: Deleting a Bubble Note on page 121, More to Explore: 

Moving a Bubble Note on page 121.

In the first several topics, you’ll learn about Bubble Notes 
from the perspective of a student/end user. You can use the 
information to train students to use Bubble Notes, or, if your 
students are capable, you can have them go through the 
exercises by themselves. 

The last several topics in the chapter are for teachers or 
someone who will be embedding and authoring instructional 
notes.
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Bubble Notes
Bubble Notes are either balloon- or cloud-shaped notes. By default, 
they open as Kurzweil 3000 encounters them in Continuous Reading 
mode.

Bubble Notes are anchored to words. In an image document, the 
anchor is a question mark in a purple box.

In a text document, the word in which the Bubble Note is anchored 
appears in purple and is underlined.

They are typically created by a teacher to give students additional 
instructions or quick questions to assess comprehension. Depending 
on the options selected for a Bubble Note, it may:

• Either open or not open.

• Read or not read when opened.

• Be read before or after a unit, or after a word is read.

• Spell a keyword.

• Contain questions in a number of different formats, including 
True or False, Multiple Choice, or Text Answer.

In this chapter, you will work with existing Bubble Notes and create a 
new one.
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Bubble Notes
Before Doing the Exercises in This Chapter
Before working with Bubble Notes, ensure the following:

• Reading Mode is set to Continuous.

• Reading Unit is set to Phrase, Line, Sentence or 
Paragraph. 

• Show Notes, on the View Annotations menu is enabled.
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Opening and Hearing a Bubble Note
If the author of the Bubble Notes kept the default settings, as soon as 
you reach a Bubble Note anchor while reading continuously, Kurzweil 
3000 automatically opens the Note and begins reading.

If Kurzweil 3000 is not reading, you can double-click on a Bubble Note 
anchor to open and hear it.

In this exercise, you’ll do both.

What You’ll Need to Do This Exercise: The “Horse’s Tale Bubble 
Notes” document in the “Sample Documents” folder.

1. Find “Horse’s Tale Bubble Notes.” Copy and rename it “my 
Horse’s Tale Bubble Notes,” then Open the document.

2. Click at the beginning of the document. 

3. Click the Read button to begin reading.

What You See and Hear: The first Bubble Note in the 
document and Kurzweil 3000 reading its contents.

Note: As usual, Kurzweil 3000 highlights words and reading 
units as it reads.

4. When you’re done, click OK in the Bubble Note to close it.
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5. Continue to read the document. The next Bubble Note will 
open when you encounter it. 

What You See and Hear: The second Bubble Note in the 
document and Kurzweil 3000 reading its contents. 

6. Because you can respond to this Bubble Note, it includes 
a Cancel button. Click Cancel for now to close the note.

7. Pause reading and go to page 2.

8. Manually open a Bubble Note by double-clicking its 
anchor. In this case, click the anchor near the word “bugle-
calls” to open its note.
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Note: You can stop Kurzweil 3000 from reading the contents of any 
Bubble Note by clicking on the main text of the Bubble Note or by 
pressing the F3 key.

What You See and Hear: The open Bubble Note and Kurzweil 
3000 reading the contents. 

9. Because you can respond to this Bubble Note, it includes 
a Cancel button. Click Cancel for now to close the note.

10. Close the document if you want to end here. Or continue 
to the next exercise to learn how to use check boxes in 
Bubble Note questions. 
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Selecting Answers for Check Box Questions
The most typical Bubble Notes are instructional ones that give you 
directions and prompts, like the one you worked with in the previous 
exercise. However, you may encounter questions in some Bubble 
Notes. 

In this exercise, you’ll answer a check box-type Multiple Choice 
question in a Bubble Note. Remember that you can use the same 
steps to respond to two other types of Multiple Choice questions: True 
or False and radio buttons. The only difference is for True or False and 
radio buttons, there is only one correct answer for you to select. In 
check box-type questions, you can select all items that apply.

What You’ll Need to Do This Exercise: The “my Horse’s Tale Bubble 
Notes” document from the previous exercise.

1. Open “my Horse’s Tale Bubble Notes” if it isn’t already 
open. 

If you do not have this document, find and Copy “Horse’s 
Tale Bubble Notes” from the “Sample Documents” folder. 
Rename and then Open it.

2. Scroll through the document and find the word “myself” at 
the end of the first paragraph. 

What You See: A Bubble Note anchor attached to the word.
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3. Double-click the anchor to open its Bubble Note.

What You See and Hear: The open Bubble Note containing a 
check box-style Multiple Choice question, and Kurzweil 3000 
reading its contents. 

Note: Some letters are underlined, indicating that you can 
press the ALT key plus the letter key to select and deselect 
that answer. 

4. To select an answer(s), you can click on the desired check 
box(es), or you can press ALT plus the underlined letter in 
the answer you want. For instance, ALT+M would select 
Slim.
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5. Then do one of the following:

• Click OK if you want to save the answer and close the 
note.

• Click Cancel if you want to close the Bubble Note 
without answering the question.

6. Save the document. This is recommended as it allows the 
student and/or teacher to review progress.

Close the document if you are ending your Tutorial 
session, or continue to the next exercise to learn how to 
respond to a Matching question. 
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Matching Answers 
You may encounter questions in some Bubble Notes that require you 
to match answers, which is what you’ll do in this exercise. 

What You’ll Need to Do This Exercise: The “my Horse’s Tale Bubble 
Notes” document.

1. Open “my Horse’s Tale Bubble Notes” if it isn’t already 
open. 

If you do not have this document, find and Copy “Horse’s 
Tale Bubble Notes” from the “Sample Documents” folder. 
Rename and then Open it.

2. Go to page 2. Find the words, “speech,” and the Bubble 
Note anchored to it.

3. Double-click the anchor to open the Bubble Note.

What You See and Hear: The open Bubble Note, containing 
a question and a text box, and Kurzweil 3000 reading its 
contents. 
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Note: Some letters are underlined, indicating that you can 
press ALT plus that letter key to select and deselect that 
answer.

4. Match answer(s): From the left-hand column, click on the 
dash line that follows the desired item, then drag the line to 
an answer in the right-hand column. 

Or you can use keyboard keys: In this case, press 
ALT+S to select “springy” from the left-hand column, then 
press ALT+F to select “flexible” from the right-hand column 
to make a match.

5. Repeat step 4 to make other matches. 

Note: Don’t worry if you do not know the answers. You can 
make random matches; this exercise is for learning how to 
use Kurzweil 3000.
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6. When you are done, do one of the following:

• Click OK if you want to save the answer and close the 
Note.

• Click Cancel if you want to close the Bubble Note 
without saving the answer.

7. Save the document. This is recommended as it allows the 
student and/or teacher to review the student’s answers.

Close the document if you are ending your Tutorial 
session. 
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Adding an Instructional Note
In this exercise, you’ll create a Bubble Note containing instructions.

1. Find and Open the “Horse’s Tale Bubble Notes” document 
from the "Sample Documents" folder, if it’s not already 
open. Copy and rename it “my Horse’s Tale Bubble 
Notes.”

2. Click where you want to place the Bubble Note anchor in 
the document.

3. From the Tools menu, select Notes, then choose Add 
Bubble Note.
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What You See: The Bubble Note dialog.

4. Select the Bubble Note Appearance you want: Balloon or 
Cloud. In this case, select Cloud.

5. Decide how and when you want the note to open. Since 
this pre-reading note should be read at the beginning of the 
text in which the Bubble Note is anchored, click Open 
before unit is read.

6. Type the content for the note. Click in the Content text box. 
For this exercise, type “As you read, think about what the 
narrator is like.”
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What You See: Content in the note.

7. Click Preview to preview the note as the reader would 
encounter it in the document.

What You See and Hear: The Preview version of the note at 
the bottom of the Bubble Note dialog, and Kurzweil 3000 
reading the contents.

8. Exit Preview mode by clicking OK inside the Preview 
version.

9. Click OK in the dialog to close it.
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What You See: In the document, the Bubble Note anchor (a 
rectangle with a question mark in it) at the cursor position.

Note: If you are using a text document, the anchor will be a 
question mark and the word to which it is attached will be 
underlined as in the example below.

10. Close the document. If you want, you can also Save it.
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More to Explore: Setting Up Uninterrupted 
Reading
By default, Kurzweil 3000 opens and reads a Bubble Note when it 
encounters an anchor. You may want to provide students with 
uninterrupted reading for some sessions and with Bubble Notes 
opening for other sessions. You can direct Kurzweil 3000 to open and 
read some or none of the Bubble Notes.

To not show and therefore not open and read the notes, disable Show 
Notes from the View Annotations menu. This option hides the 
Bubble Note anchors. 

To not open and read a specific Bubble Note, click the desired note 
anchor. From the Tools Note menu, choose Edit Bubble Note. In the 
Bubble Note dialog, deselect the Open while reading option. 
Deselecting this option displays the Bubble Note anchors in the 
document but does not open the notes.

More to Explore: Editing a Bubble Note
To edit existing Bubble Notes, select the anchor, then use Edit Bubble 
Note to make any changes you want. Edits can include changes to 
options as well as changes to content.
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More to Explore: Deleting a Bubble Note
To delete a Bubble Note, select its anchor, then choose Delete Note 
from the Tools Note menu.

More to Explore: Moving a Bubble Note
To move a Bubble Note, click its anchor and drag it to a new location.
Kurzweil 3000 for Windows Tutorial 121



More to Explore: Moving a Bubble Note
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8 Writing and Self-
Correction Tools

In this chapter, you’ll learn about:

• Writing and Editing in Kurzweil 3000 on page 125.

• Creating a Text Document on page 126.

• Hearing What You Type on page 127.

• Using Word Prediction and a Homophones List on page 129.

• Dragging and Dropping Text on page 133.

• Copying and Pasting an Image on page 135.

• Changing Fonts and Formatting on page 138.

• Spell Checking a Document on page 140.

• Finding Homophones on page 142.
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In addition, you’ll find More to Explore: Setting Tabs and Margins 
on page 144 and More to Explore: Finding and Replacing Text on 
page 145. 
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Writing and Editing in Kurzweil 3000
Kurzweil 3000 provides a wide range of features to assist with writing 
tasks:

• Notes and Highlighter tools are useful in taking notes and 
marking main ideas and supporting details during the reading 
and research phase. See Chapter 5, Notes and the Creation of a 
Study Document on page 73. See Chapter 6, Highlighting and the 
Creation of a Summary Document on page 89.

• The Extract command is a powerful tool for creating 
summaries and outlines that aid in studying and mastering 
material and in the composition stage. See Chapter 6, 
Highlighting and the Creation of a Summary Document on page 89.

• Reference tools are also accessible while writing and editing. 
See Chapter 4, Reference Tools on page 59.

In this chapter, you’ll work with Speak as Typing, Word Prediction 
and Homophones list and use some typical editing functions such as 
dragging and dropping text and images and spell checking. 

To show the Writing toolbar:
To do the exercises in this chapter, you must have the Writing toolbar 
showing.

Click the blue Toggle along the left edge of the Kurzweil 3000 toolbar 
area to show or hide the Study Skills toolbar. You can also use the 
shortcut keys CTRL+SHIFT+F12.

The blue Toggle shows or hides the Writing toolbar
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Creating a Text Document 
When you type your own document in Kurzweil 3000, you are creating 
text that Kurzweil 3000 can read back to you.

1. Click the New button in the Main toolbar to open an empty 
document.

2. Begin typing. You can use Kurzweil 3000 just like any text 
editor or word processor.

What You See: What you type appears in the document 
display area of the Kurzweil 3000 window.

3. Continue to the next exercise.
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Hearing What You Type
The Speak as Typing setting is in the General Options pane.

1. Open the Tools menu and select Options.

What You See: The General Options pane.

2. In the Speak as Typing box, select Whole Words to hear 
Kurzweil 3000 speak each word you type each time you 
press the Spacebar key between words.

3. Click OK.

4. Begin typing again to hear Kurzweil 3000 read what you 
type.

5. Try another Speak as Typing option if you want.

6. When you’re done, return the Speak as Typing options to 
their original settings.
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7. Save the document if you intend on continuing to the next 
exercise or if you want to use it again later. Close it if you 
want to end here.
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Using Word Prediction and a Homophones List
As you type, Word Prediction helps you to complete words or to select 
the next word from a list of possibilities. 

In addition, there is a comprehensive set of Vocabulary List features 
for building, editing and enabling whatever vocabulary lists your 
curriculum calls for. Kurzweil 3000 comes with some lists, such as 
Homophones and Confusables.

For more information on the Vocabulary List features, see Kurzweil 
3000 online Help or the Kurzweil 3000 for Windows User’s Guide.

In this exercise, you’ll learn how to insert a word from the Word 
Prediction list and how to use homophone words in Word Prediction.

What you’ll need: 

• The Writing toolbar showing: Click the blue toggle along the 
left edge of the toolbar area, or press CTRL+SHIFT+F12.

• An open text document in which you can type and edit, such 
as the one you created in the previous exercise.
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1. Click the Word Prediction button.

What You See: The Word Prediction dialog.

Notice the thumbtack in the upper-left-hand corner. By default, 
this dialog is stationary. To have it move as you type, click the 
thumbtack.

2. Begin typing “Type some text.”

Click the 
Thumbtack to 
have the dialog 
move with text as 
you type.
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Chapter 8. Writing and Self-Correction Tools
What You See: The Word Prediction dialog with a list of 
suggestions for the word you are typing. 

Notice that the word “some” in the list is highlighted. This 
means that it is an entry in the Homophones list.

3. Double-click the highlighted word.

What You See and Hear: The Homophone dialog containing 
the word’s related homophones. Kurzweil 3000 spells and 
reads the definition of the word while highlighting.
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Using Word Prediction and a Homophones List
4. To see and hear another homophone definition, click on it.

5. When you’re done, click the dialog Close button.

6. To insert one of the suggestions, click the number next to 
the desired word.

7. When you’re done with Word Prediction, click the dialog 
Close button.

8. Continue to the next exercise. If you need to end here, click 
the document Close button. 
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Dragging and Dropping Text 
You can drag and drop text within a text document, within an image 
document and among image and text documents. You can even drag 
and drop text into Sticky Notes and Footnotes.

This is very useful, for example, when adding quotations into your 
research papers, eliminating rekeying of large chunks of text. 

In this exercise, you’ll work with multiple open documents and drag 
and drop text from one document to another.

What You’ll Need to Do This Exercise: “Time Travel” from the 
“Sample Documents” folder and an open text file such as the one you 
used in the previous exercise.

1. Find the “Time Travel” document from the "Sample 
Documents" folder and Open it.

2. Since this is a sample document, make a copy of it by 
saving it under a new name:

From the File menu, choose Save As.

In the Save As dialog, click and type “my Time Travel” into 
the File Name box.

Click Save and Close the dialog.

3. If you don’t have a new document open from the previous 
exercise, click New in the Main toolbar to create one now.

4. Display the documents side by side:

From the Window menu, select Tile Vertically.
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Dragging and Dropping Text
What You See: Both documents in the window, side by side.

5. From the document with the text and image, select the text 
you want to drag and drop. Try the title, “Time Travel.”

6. Drag and drop the text to the desired location.

What You See: A copy of the title text in the text document.

7. Continue to the next exercise.
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Copying and Pasting an Image
There may be times when you want to copy and paste an image into 
a document.

In this exercise, you’ll continue to work with multiple open documents 
and copy and paste an image from one document into another.

What You’ll Need to Do This Exercise: “my Time Travel” and the text 
document that you used in the previous exercise displayed side by 
side.

1. In “my Time Travel,” press the Page Down key or scroll to 
the bottom of the page, where there is an image.

What You See: The image document and the text document 
displayed side by side.

2. From the Edit menu, select Image Selector. 
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Copying and Pasting an Image
What You See: In the “my Time Travel” document, the cursor 
is now a crosshair.

3. In the image, click at the upper-left-hand corner where 
you’d like to begin your selection. Drag the rectangle that 
appears until it encloses the part of the image you’d like to 
copy, then release the mouse button.

What You See: The Image Selector’s black, sizable border.

4. Copy the image by doing one of the following:

• Click the right mouse button and choosing Copy.

• Press CTRL+C.

5. Paste the image:

Click in the text document where you want to place the 
image, then choose Paste from the right mouse button 
menu, or press CTRL+V.
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Chapter 8. Writing and Self-Correction Tools
What You See: The copied image in the text document.

6. You can Close both documents with or without saving.

By default, Kurzweil 3000 saves the text document in Rich 
Text Format (.rtf). Saving the file in text (.txt) format results 
in the loss of any images in the text document.

Original Image DocumentImage Dropped into the Text Document 
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Changing Fonts and Formatting
You can change the font, size, style or color of text in a document in a 
number of ways:

• As you compose, select text and apply the change.

• As you compose, apply the change to text typed after the 
current cursor position.

• Apply changes throughout a document.

In this exercise, you’ll change font and formatting as you compose, 
then apply changes throughout a document.

What You’ll Need to Do This Exercise: 
• A new text document.

• The Writing toolbar visible.

1. In a text document, type some text.

2. Change the font size for text you want to type.

In the Font Size box, select the desired value. Try 42. 
Then type some more text.

Font Size Style Paragraph 
Alignment

Line 
Spacing

Spell Checking
and Word Prediction
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What You See: Font size changed for text you type.

3. Change the font of selected text:

Select text, then select another font from the Font Type 
box. Try Courier.

4. Try changing the alignment:

Click the line you want to re-align, then select the desired 
alignment. Try Center.

5. Continue to the next exercise.
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Spell Checking a Document
Kurzweil 3000 spell checker works in text as well as in image 
documents. See Kurzweil 3000 online Help or the Kurzweil 3000 
User’s Guide for information about spell checking in image documents 
under Editing Image Documents.

What You’ll Need to Do This Exercise: An open text document.

1. Click where you want to start spell checking, then click the 
Spell Check button in the Writing toolbar.

What You See: If Kurzweil 3000 finds a word it thinks is 
incorrect or isn’t in the dictionary, the Spelling Correction 
dialog appears. 

Note: The words you see in your dialog will be different from 
the example below.
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2. Decide how you want Kurzweil 3000 to handle each error 
it finds. Try the following options:

To ignore the possible error, click Skip to skip this instance 
or Skip All to skip all instances.

To correct an error, select a word in the Suggestions list 
or type your correction into the Change To box. Click 
Change to change this instance or Change All to change 
all instances.

To hear the contents of the Change To box, click Read.

To add the word to your spelling dictionary, click Add.

3. When you’re done, click the Exit button in the Spelling 
Correction dialog.

4. Close the document.
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Finding Homophones
Another helpful self-correction tool is Find Homophone, accessible 
from the Edit menu.

For this exercise, try using the document, “Horse’s Tale” from the 
"Sample Documents" folder. The examples in this exercise are from 
that document. 

1. Click where you want to start the find; from the Edit menu, 
choose Find, then Homophone II.

What You See: If Kurzweil 3000 finds a word in the document 
that is a homophone, the Homophone dialog appears. 

If you’re using the “Horse’s Tale” document, the first 
homophones Kurzweil 3000 finds are “tale” and “tail.”
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2. To hear Kurzweil 3000 spell a word and read its definition, 
click the word.

To find the next homophone, click Find Next 
Homophone.

To find the next instance of the homophone, click Find 
Next “Tale.”
Note: In a text document, the Replace button is active. 
Click it to replace the current word with a homophone from 
the Homophone dialog.

3. When you’re done, click the dialog Close button.

4. Close the “Horse’s Tale” document.
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More to Explore: Setting Tabs and Margins
The ruler sets tabs and margins for a typed document. You can find 
the Show Ruler setting in the General Options pane from the Tools 
menu.

To use the ruler to set margins, drag the left margin indicator (the red 
bar) to the desired left margin. Drag the right margin indicator (the blue 
bar) to the desired right margin.

To set tabs, double-click at the location for the tab. A black dot 
appears, representing the tab. To remove a tab setting, double-click 
on the black dot.

Left Margin 
Indicator

Right Margin 
Indicator

Tab Indicator
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More to Explore: Finding and Replacing Text
You can search for any text string in an image or text document. Note: 
in an image document, the Replace function affects the underlying 
text, not the image text you see on the screen.

To: Do:

Find text. From the Edit menu, choose Find, then 
select Text.
In the Find bar, type the text you want to 
find. 

You can replace text from the Find bar by 
clicking Replace.

Find and Replace. From the Edit menu, choose Find, then 
select Replace Text.
In the Replace dialog, type the text you 
want to find and the replacement text, then 
click Replace.

To see the replacement in an image 
document, choose Edit Underlying Text 
from the Correct Recognition menu in the 
Edit menu.
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9 Vocabulary Lists

In this chapter, you’ll learn about:

• Kurzweil 3000 and Vocabulary Building on page 148.

• Creating a Vocabulary List by Extracting Words on page 149. 

• Setting Options for a Vocabulary List on page 154.

• Finding a Vocabulary List’s Words on page 156.

• Disabling a Vocabulary List on page 158.
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Kurzweil 3000 and Vocabulary Building
Kurzweil 3000 and Vocabulary Building
If weekly vocabulary-building lists and vocabulary lists based on 
subjects or units of study are integral parts of your curriculum, the 
Kurzweil 3000 Vocabulary List feature can help you automate the 
process of creating your lists, while enabling your students with 
special needs to access and use the lists within Kurzweil 3000. 

With this feature, you can create, edit, and enable or disable lists as 
well as add lists to Word Prediction and the Find and Highlight menus.

If you went through the writing and editing exercises in the previous 
chapter, you have already been introduced to a Kurzweil 3000-
provided list, the Homophones list.

In the following exercises, you’ll extract words from a document to 
create a vocabulary list, enable the list and see how the list works as 
a student is working with Kurzweil 3000.
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Creating a Vocabulary List by Extracting 
Words
You can create a vocabulary list in Kurzweil 3000 in a number of ways:

• By editing an existing list and renaming it.

• By extracting all the words from a document.

• By extracting words that you’ve highlighted in a document.

In this exercise, you’ll walk through extracting all the words in a 
document. 

What You’ll Need to Do This Exercise: The “Time Travel” document 
from the "Sample Documents" folder.

1. Open the document from which you want to extract words 
for a new vocabulary list.

2. From the Tools menu, select Vocabulary Lists.

What You See: The Vocabulary Lists dialog.

3. In the Vocabulary Lists dialog, click New.
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What You See: The New Vocabulary List dialog.

4. In the New Vocabulary List dialog, click Create 
Vocabulary List from “Time Travel.kes.”
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What You See: The Vocabulary List dialog with the Extract 
all words option already selected.

5. Click Next.
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Creating a Vocabulary List by Extracting Words
What You See: The next New Vocabulary Lists dialog 
containing the list of extracted words.

Notice that all the words in the document, including common 
words such as “an” and “be,” are in the list. It’s possible to 
remove those words, as you’ll do next.

6. In the New Vocabulary List dialog, select Common 
English words, then click Remove.

What You See: Some words from the Words in list area are 
now in the Words removed from list area.

7. To remove a word from the list, select it from the Words in 
list area, then click the Right arrow button.

To return a word to the list after removing it, select it from 
the Words removed from list area and click the Left arrow 
button.
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8. When you’re done, click Next.

What You See: The Save dialog.

9. Give the new Vocabulary List file a name by double-
clicking the word “New,” and typing the word “Class.”

10. Click Save.

What You See: The Vocabulary Lists dialog now contains 
the new “Class Vocabulary List.” It is enabled (checked) by 
default.

11. Click OK.

12. Continue to the next exercise.
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Setting Options for a Vocabulary List
You can set a number of options for a vocabulary list. For complete 
details, see Kurzweil 3000 online Help or the Kurzweil 3000 for 
Windows User’s Guide.

In this exercise, you’ll make the “Class Vocabulary List” you created in 
the previous exercise available on the Find menu so that students can 
find the words as they read.

1. From the Tools menu, select Vocabulary Lists.

2. In the Vocabulary Lists dialog, ensure that the Class 
Vocabulary List check box is checked. Then click 
Options.

What You See: The list’s Options dialog.
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3. Click Add this list to the Find Menu to have Kurzweil 
3000 add the list to the Find menu.

4. Click OK to close the dialog.

5. Click Apply, then click OK in the Vocabulary Lists dialog.

6. To take a look at the results, continue to the next exercise.
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Finding a Vocabulary List’s Words
Once you create or enable a vocabulary list, it’s ready for students to 
use as they read in Kurzweil 3000.

For this exercise, open the “Time Travel” document from the "Sample 
Documents" folder.

1. From the Edit menu, choose Find, then select Class 
Vocabulary List.

Note: You can also find homophones in any document in the 
same way.
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What You See: Kurzweil 3000 highlights the first word it 
encounters from the vocabulary list and opens the Find dialog. 

2. To find the next word from the list, click Find Next <name 
of the list you are using>.

To find the next instance of the currently highlighted word, 
click Find Next <word>. 

3. When you’re done, click the Close button to close the Find 
dialog.

4. Close the “Time Travel” document.
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Disabling a Vocabulary List
When your student or class moves on to another week’s or unit’s 
words, it’s easy to disable the old vocabulary list: From the Tools 
menu, select Vocabulary Lists. In the Vocabulary Lists dialog, 
deselect or click to uncheck the list’s check box, then click OK.
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10 Online Material

In this chapter, you’ll learn about:

• Working with Online Material on page 160.

• Reading Websites on page 161.

• Applying Reference Tools to Websites on page 163. 

• Searching for Online Books on page 165.

• Using Simple Search and Download on page 166

• Opening Downloaded Files on page 169.
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Working with Online Material
The ability to access and work with online material means you have a 
broader range of research and resource material that you can use with 
Kurzweil 3000. 

The Read the Web feature from the Read menu lets you access and 
read Web pages, while the Online menu enables you to search for and 
download files from a variety of websites and from the Kurzweil 
Classic Literature CD Version 4. You can also get news and product 
updates from Kurzweil Educational Systems.

In addition, Kurzweil 3000 provides a variety of features for working 
with online material, including reference tools, highlighting and notes.

Before you can access online material, you must have the following:

• An Internet connection.

• Mozilla Firefox or Microsoft Internet Explorer web browser.

If you plan on using Search for Books from the Classic Literature CD, 
you can find the CD in the product packaging. 
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Reading Websites
You can use the Read the Web feature with either Microsoft Internet 
Explorer or the recommended Mozilla Firefox browser. If both 
browsers are installed, choose the one you want to use by selecting it 
in the Reading Options pane, accessible from the Tools Options 
menu. For instructions on installing Firefox, see Kurzweil 3000 online 
Help.

When you use Read the Web in either browser, you have access to 
the browser’s features, including search, as well as access to other 
websites, in addition to Kurzweil 3000 reading and reference tools.

In this exercise, you will go to a website of your choice from Kurzweil 
3000 and use Kurzweil 3000 to read its contents. The browser used in 
this exercise is Mozilla Firefox. 

1. In Kurzweil 3000, open the Read menu, choose Read the 
Web.

What You See: The browser window, and the Kurzweil 3000 
Read the Web toolbar.

2. Click in the browser Address box, and type the desired 
website address. 

Kurzweil 3000 Read the Web Toolbar in Mozilla Firefox
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Reading Websites
3. Once the browser displays the page, click where you want 
Kurzweil 3000 to begin reading.

Note: If there is a hyperlink at that location, click near the 
text and use the arrow keys to navigate to the exact 
location.

4. Click the Read button.

What You See and Hear: Kurzweil 3000 reads and highlights 
the page content.

5. Just as in a Kurzweil 3000 document, you can use the 
Read Mode, Read By reading unit, and WPM features 
available from the Read the Web toolbar to control the 
reading speed. You can also use the Next and Previous 
buttons in the Read the Web toolbar to move forward and 
backward by the current unit respectively.

6. Click the Pause button to stop reading.

7. Continue to the next exercise to use reference tools in 
Read the Web mode.
162



Chapter 10. Online Material
Applying Reference Tools to Websites
In this exercise, you’ll use Kurzweil 3000 Reference tools to look up 
words from the web page that you opened in the previous exercise.

Note: Information presented in this exercise is based on Mozilla 
Firefox.

1. In the browser window, click the word you want to look up, 
making sure the word is not part of a link (that is, it is not in 
color and is not underlined).

Then in the Read the Web toolbar, click one of the 
following:

• Dictionary to see the definition(s) for the word.

• Syllables to hear the word pronounced phonetically. 

What You See: The Dictionary or Syllables dialog. 

2. If you’re trying Dictionary, click the Read button in the 
Kurzweil 3000 toolbar to hear the contents. Click the dialog 
Close button when you’re done.

3. To not have the Kurzweil 3000 window visible so you can 
see the website again, click the Minimize button at the top 
right of the window.

Note: Exiting Kurzweil 3000 shuts down the Read the 
Web feature.
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Teaching and 
Learning Tip

In preparing material for class work, consider saving the 
contents of a web page by doing the following:

While in Read the Web mode, maximize the Kurzweil 
3000 window by clicking Kurzweil 3000 in the Windows 
taskbar, choose Save As from the File menu, and 
Save the file in text (.txt) format. 
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Searching for Online Books
Kurzweil 3000 online options enable you to search for and download:

• Electronic books and material from websites, such as Project 
Gutenberg, Bookshare.org and Baen Free Library. Note that 
some websites require a subscription.

• Text files from the Classic Literature CD Version 4.

• Magazine articles (currently from Talking Newspaper UK and 
Bookshare.org).

You can search for books by author and/or title or use a specific query. 
Your searches can be simple or complex to help you narrow down the 
result. The search procedure for magazines is similar.

In addition, you can look up a word or phrase from a variety of online 
encyclopedias. See More to Explore: Using Online Encyclopedias on 
page 70.
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Using Simple Search and Download
1. In the Kurzweil 3000 window, open the Online menu and 

choose Search for Books.

What You See: The Online Search dialog. 

2. Click the Author button to search by author name. In the 
Contains box, type any part of the author name.

You can also click Title to search by title, and type any part 
of the title.

Try Author. Then in the Contains box, type “Dickens.”

3. In the Sites area, specify the sites you want to search. By 
default, all sites are checked, so click the check boxes of 
the sites you don’t want.

For this exercise, uncheck all except Project Gutenberg.
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What You See: The desired site(s) checked.

4. Click OK.

5. Select each desired item and click OK. 

Kurzweil 3000 downloads the materials in the background 
and lets you know when the download is complete. 

If the book you selected to download is from the 
Bookshare.org website, and it is copyrighted, and this is 
the first time you are requesting to download from the site 
during this Kurzweil 3000 session, the site may request 
your password. If you are not a member of Bookshare.org, 
you will not be able to download copyrighted books.
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What You See: The Download Status dialog. 

When the search is finished, available books you can 
download appear in Items available for Download.

6. Click the check boxes of the files you want to download.

7. Click OK.

What You See: A message indicating that the download is 
complete.

8. Continue to the next exercise to learn how to open 
downloaded files.
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Opening Downloaded Files
1. If you just downloaded files, click the Open button. If you 

want to open a previously downloaded file, you can find it 
in the "Download" folder.

What You See: A message dialog asking if you want to open 
the recently downloaded file or files.

2. Click OK.

Depending on the size of the file, it may take a few minutes 
to open. 

3. You can now Read the file.

4. Kurzweil 3000 saves downloaded documents by default 
file names. After opening a downloaded document, you 
can save the file with another name.
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11 Test Document 
Preparation

This chapter is primarily for teachers whereas the next 
chapter is for students. 

If you are a teacher, we recommend that you go through the 
next chapter to familiarize yourself with the features 
students use to take tests in Kurzweil 3000. That way, you 
can also train your students on test taking in Kurzweil 3000. 
If your students are older and capable, have them go 
through the next chapter by themselves.

In this chapter, you’ll learn about:

• Preparing Tests on page 173.

• Using Fill in the Blanks on page 174.
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• Customizing Kurzweil 3000 for Test Taking on page 175. 

• Selecting the Test Taking Toolbar on page 176.

• Saving the Toolbar with the Test Document on page 177.

• Locking Features on page 179.
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Preparing Tests
With Kurzweil 3000, it’s easy to prepare and administer tests, to 
accommodate a wide range of student abilities and to provide 
performance feedback. 

In preparing a test, start by doing one of the following:

• Scanning a document. See Scanning a Document into 
Kurzweil 3000 on page 31.

• Opening a document from another application. 

• Creating a document from scratch in Kurzweil 3000 using the 
writing editor. See Creating a Text Document on page 126.

• Creating annotations containing questions in a document, 
then using the Extract feature to build a new document with 
the questions ready to apply as a test. See Creating a Study 
Document by Extracting Notes on page 85.

Kurzweil 3000 can handle different types of tests including:

• Multiple Choice: Have students use color Highlighters, text 
Circle tools, Text Notes or drag and drop.

• Essay: Put an empty Text Note in the test as a starting place 
for the students.

• Fill in the Blanks (and True or False): Use the Fill in the 
Blanks feature as described in the following exercise.
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Using Fill in the Blanks 
You can use this feature for Fill-in-the-Blank or True or False tests, 
worksheets, forms and applications.

Note: This feature only works with black and white image documents, 
and on one page at a time.

What You’ll Need to Do This Exercise: Open the “Time Travel Quiz” 
document from the "Sample Documents" folder, and Save and 
rename it “my Time Travel Quiz.”

1. From the Tools menu, select Fill in the Blanks or click the 
Blanks button.

What You See: An empty Text Note at every blank line. 

2. Save the document. “my Time Travel Quiz” is now ready 
for students to use in the next chapter. 
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Customizing Kurzweil 3000 for Test Taking
There are two main reasons why you would want to customize 
Kurzweil 3000 features for test taking:

• To turn off certain features that students will not need or that 
will distract them.

• To accommodate students who have special challenges.

The following is a short list of some of the features that you can use to 
customize Kurzweil 3000 to easily accommodate students’ 
requirements for regular use as well as for test taking. 

• Change the Reading Speed from the Reading toolbar.

• Turn Speak as Typing on or off as a proofreading tool. 

• Show or hide certain toolbars. 

• Save toolbar(s) with a document.

• Use annotations to embed helpful hints. See Creating and 
Working with Sticky Notes and Text Notes on page 77.
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Selecting the Test Taking Toolbar
The sample toolbar sets are designed for specific learning tasks. In 
testing, you may want to select the Test Taking toolbar set for its 
reduced set of tools. Students can adjust reading speed and enlarge 
text for test-taking comfort, while having access to the Highlighters for 
highlighting multiple choice answers.

Note: When customizing settings for a student using the Kurzweil 
3000 Standalone edition, make the changes on the Kurzweil 3000 
system he or she will be using. 

For now, try applying the Test Taking toolbar set. 

You can find all the other ways to customize Kurzweil 3000 for test 
taking, including disabling features and customizing toolbars, in 
Kurzweil 3000 online Help or the Kurzweil 3000 for Windows User’s 
Guide.

1. Place the cursor in the toolbar area of the Kurzweil 3000 
window, then press the right mouse button.

2. Choose Apply Toolbar Set, then select Test Taking.

What You See: The Test Taking toolbar.

Note: To revert to the default Kurzweil 3000 Main toolbar, 
select Classic from the Apply Toolbar Set menu.
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Saving the Toolbar with the Test Document
Saving a toolbar with a test document can be beneficial for students 
taking a test using Kurzweil 3000. All the tools they need can be on 
the toolbar, saving time and helping students focus on the test content 
rather than on finding the tools they need.

What You’ll Need to Do This Exercise: The Test Taking toolbar set 
applied and displaying in the “my Time Travel Quiz” document. 

1. Have the desired test document open.

2. From the File menu, select Properties.

What You See: The Document Properties dialog.

3. In the Document Properties dialog, click General
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4. Select Save Toolbars in Document.

5. Click OK.

6. If you close and re-open the document, the Test Taking 
toolbar should be in the toolbar area.

7. Continue to the next exercise if you want to learn how to 
lock features.
178



Chapter 11. Test Document Preparation
Locking Features
You can lock or password-protect various features either to 
accommodate specific student requirements or for test taking. By 
default, all features are available to users. When you lock features, it 
affects only the machine on which you performed the lock. In addition, 
it’s possible to save locks to a document.

See Kurzweil 3000 online Help or the Kurzweil 3000 for Windows 
User’s Guide for information about password protection and saving 
locks to a document.

In this exercise, you’ll turn some features off.

What You’ll Need to Do This Exercise: The “my Time Travel Quiz” 
document from previous exercises open in Kurzweil 3000. The Test 
Taking toolbar should be displaying.

1. Take a look at the Test Taking toolbar.

What You See: The Test Taking toolbar. Notice that the Word 
Prediction and Spell Check buttons are in enabled state.
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Locking Features
2. From the Tools menu, choose Lock Features.

3. Click Writing in the left column to display the Writing 
pane.

What You See: The Lock Features Writing pane.
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Chapter 11. Test Document Preparation
4. Select Disabled for the Word Prediction and Spell 
Check options.

5. Click OK.

What You See: In the Test Taking toolbar, the Word 
Prediction and Spell Check buttons grayed out.

6. Repeat the above steps to re-enable the features.

7. Close the document. Go to the next chapter to learn how 
to take a test in Kurzweil 3000.
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12 Test Taking 

This chapter is primarily for students. Teachers, however, 
can go through and train students on the material. In this 
chapter, you’ll learn about:

• Test Taking Using Kurzweil 3000 on page 184.

• Reading Through the Test on page 185.

• Filling in Your Name on page 186.

• Using Fill in the Blanks on page 187.

• Using the Text Circle Tool for Multiple Choice on page 188.

• Dragging and Dropping an Answer on page 190.

• Reading Back Test Questions and Answers on page 192.

• Saving Your Test Document on page 193.

• Printing Your Test on page 193.
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Test Taking Using Kurzweil 3000
Before you take a test, find out what type of test it will be: Fill in the 
Blanks, Multiple Choice, True or False, Essay or a combination. Find 
out what Kurzweil 3000 tools you will be allowed to use.

When you use Kurzweil 3000 to take a test, be sure to read the test 
before answering the questions and read it again after you’ve 
completed the test to make sure your answers are correct. 

For exercises in this chapter, use “my Time Travel Quiz,” prepared in 
the previous chapter. If you are a student, see your teacher for this 
document.
184



Chapter 12. Test Taking
Reading Through the Test
The document “my Time Travel Quiz” should be open.

1. Click at the very beginning of the document, and click the 
Read button.

2. Click the Pause button to stop reading at any time.

3. Continue to the next exercise to fill in your name.
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Filling in Your Name
The document “my Time Travel Quiz” should be open.

1. In the Name line, look for a little orange box. This is a Text 
Note.

2. Click the box and type your name. 

If you make mistakes, you can correct them by using the 
Backspace key. You can also use the Read button to read 
what you have typed.

3. Continue to the next exercise to fill in answers.
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Using Fill in the Blanks 
The document “my Time Travel Quiz” should be open. 

In this exercise, you will work with the True or False section of the 
document, starting with question 1. 

Tips: 
• To navigate among the notes, use the TAB key to go forward, 

and SHIFT+TAB to go backward.

• For short answer or essay responses, you can use ENTER to 
go to another line, CTRL+X to cut, and CTRL+C to copy and 
CTRL+V to paste text in Kurzweil 3000 Text Notes.

• You can also have Kurzweil 3000 read what you have written.

1. In question 1, find the Text Note box above the line.

2. Click inside the box.

3. Type “F” or “False.”

4. If you want more practice, continue to the next questions 
and fill in answers in the same way.

5. When you are ready, continue to the next exercise.
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Using the Text Circle Tool for Multiple Choice 
In this exercise, you will work with Question 8 in the Multiple Choice 
section of the document and use a Text Circle tool to select answers. 
Note that you could do the same task with a Highlighter.

What You’ll Need to Do This Exercise: 
• The document “my Time Travel Quiz” should be open. 

• Having the Test Taking toolbar set showing would be very 
helpful. To show the Test Taking toolbar set, place your 
cursor in the toolbar area, press the right mouse button to 
open the Toolbar shortcut menu, and select Test Taking.

The following is the Test Taking toolbar set.
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1. In the “my Time Travel Quiz” document, press the Page 
Down key until you see question 8.

2. Click the Circle tool in the Test Taking toolbar.

3.  In question 8, drag the Circle tool over the correct answer, 
“physicist.”

What You See: A circle around the answer.

4. When you are done, click on the Circle tool button again.

5. Continue to the next exercise.
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Dragging and Dropping an Answer
You can also drag and drop your answers. 

You should have the document “my Time Travel Quiz” open.

In this exercise, you will work with question 9 at the top of the next 
page in the document.

1. Press the Page Down key from page 1 until you see 
question 9.

2. Select an answer:

From the word list, double-click on the word “relative.”

What You See: The selected word is highlighted.

3. Drag and drop the answer:

Place the mouse cursor on the word.

Press and hold down the left mouse button and move the 
text to the answer line in question 9.

Then release the mouse button.
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Tip:
Dragging and dropping text also works for True or False, Fill in the 
Blanks and Essay responses if part of the answer is on the test, or 
if your teacher allows you to use a study document that might have 
the answer on it.

What You See: The word is on the answer line.

4. When you are done, continue to the next exercise.
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Reading Back Test Questions and Answers
When you have completed a test, always go back and check your 
answers. 

1. Click at the beginning of the test or click inside the Answer 
(Text Note) you want to check.

2. Click the Read button.

If you left a blank line, Kurzweil 3000 will pause. 

3. Correct any wrong answers.
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Saving Your Test Document
Remember to save your test document often as you work.

Click the Save button.

Printing Your Test 
It’s a good idea to print your test document when you are done. You 
may also need to print it to hand it in to your teacher.

Click the Print button in the toolbar area.

Congratulations
You’ve just learned how to take a test using Kurzweil 3000. 
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Kurzweil 3000 
Scanning Sample

Rikki Tikki Tavi by Rudyard Kipling

At the hole where he went in
Red-Eye called to Wrinkle-
Skin.
Hear what little Red-Eye 
saith:
"Nag, come up and dance 
with death!"
Eye to eye and head to head,
(Keep the measure, Nag.)
This shall end when one is 
dead;
(At thy pleasure, Nag.)
Turn for turn and twist for 
twist--
(Run and hide thee, Nag.)
Hah!  The hooded Death has 
missed!
(Woe betide thee, Nag!)

This is the story of the great war that Rikki-
tikki-tavi fought single-handed, through the 
bath-rooms of the big bungalow in Segowlee 
cantonment. Darzee, the Tailorbird, helped 
him, and Chuchundra, the musk-rat, who 
never comes out into the middle of the floor, 
but always creeps round by the wall, gave 
him advice, but Rikki-tikki did the real fighting.

He was a mongoose, rather like a little cat in 
his fur and his tail, but quite like a weasel in 
his head and his habits. His eyes and the end 
of his restless nose were pink.  He could 
scratch himself anywhere he pleased with 
any leg, front or back, that he chose to use. 
He could fluff up his tail till it looked like a 
bottle brush, and his war cry as he scuttled 
through the long grass was: "Rikk-tikk-tikki-
tikki-tchk!"
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